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Writing about software as it is going through development is both a challenge and a blast. It’s fun to see
the newest features and begin working with them long before they are publicly available. But it’s also a
challenge because many of the features in the new software aren’t “set” —some tools may disappear
and others appear before the software is finally released. Because | wrote First Look Microsoft Office
2010 based on an early beta of the software, some of the features and functionality have changed in the
release version. This document provides you with an update on some of the features | wrote about in
the book.

| hope you’re enjoying your version of Microsoft Office 2010, now that it is available in wide release. |
think it’s a smart, creative, collaborative release that will help us look better, work together more
effectively, and be flexible in when—and how—we choose to get the job done. ©

Here’'s what you’ll find where in these release notes:
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Introduction

Who Uses Office 20107

Page xiv: | would add a new scenario here: Maria is a writer and editor who works part-time at home
and part-time at the office. She relates to the team using SharePoint Workspaces but then also posts the
files she’s working on in Word to her Windows Live SkyDrive account so that she can always access the
most current versions of the files, whether she’s working at her home computer or sitting at her office
desk.

What’s In Microsoft Office 20107

Page xv: Office Mobile 2010 is a separate version of Microsoft Office 2010 that is now available in wide
release. You can use touch on your phone as you work with Microsoft Word Mobile 2010, Excel Mobile
2010, PowerPoint Mobile 2010, OneNote Mobile 2010, and SharePoint Workspaces Mobile 2010. You
can review, edit, update, share, and sync your file changes easily, all from your Windows-based
smartphone.

Office 2010 System Requirements

e Memory: 256 MB (512 MB recommended)
e Hard disk space: 3.5 GB [for Office 2010 Professional Plus]



CHAPTER 1

Welcome to Office 2010

Collaborate Easily and Naturally

Co-authoring features are available in Word 2010, PowerPoint 2010, and in OneNote 2010. Using the
Office Web Apps, you can use co-authoring features with Excel Web App and OneNote Web App.

Work Anywhere—and Everywhere

Office Mobile 2010 includes Word Mobile 2010, Excel Mobile 2010, PowerPoint Mobile 2010,
SharePoint Workspace Mobile 2010, and OneNote Mobile 2010.

Exploring the Ribbon

The release version of Office 2010 programs now have the File tab where the Microsoft Office symbol
used to be. Clicking File takes you to the Backstage view.

Figure 1-1 Exploring the Office 2010 Ribbon.



Contextual Tabs

The Picture Tools Format contextual tab now shows a different look for the tools in the Adjust group:
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Figure 1-3 The contextual tab provides options related to the task you are performing.

New Backstage View

In the release, Microsoft Office Backstage view includes the Save & Send tab instead of (in beta) the
Share tab.
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Figure 1-4 Backstage view helps you find, prepare, manage, save, send, and print the files you create.



CHAPTER 2

Express Yourself Effectively and Efficiently

Enhancing and Streamlining Communications in Outlook 2010

Are you hooked on social media? Aren’t we all? Now you can keep up-to-date with the status updates of
colleagues, clients, friends, and family by using the Outlook Social Connector, built right into Outlook
2010. You can click the People Pane tool in the View tab to display the People Pane. After you set up the
feature, you'll be able to see a list of all your interactions with the contact, including status updates, files
you’ve sent and received, and previous messages.
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Figure 2-11 The Outlook Social Connection enables you to stay in sync with your online friends and fans.



CHAPTER 3

Collaborate in the Office and Around the World

Co-Author Files Across Applications

Note In order to use the presence feature of co-authoring, in which you can see which other authors
are available online as you work, you need to be running Office Communicator 2007 R2. Office 2010
users in a business environment also need SharePoint Workspace 2010 in order to collaborate in real
time on documents. Home users can save their files to Windows Live SkyDrive and collaborate
simultaneously using the Office 2010 Web Apps.



CHAPTER 4

Create and Share Compelling Documents with
Word 2010

Use Language Tools, and Translate on the Fly

The last bullet should be “Choose Translation Language”

Start with the last item first if this is the first time you’re using the Translation tools. When you click
Choose Translation Language, the Translation Language Options dialog box appears so that you can
choose the language you’re translating to (for the Mini Translator tool) and choose the language you're
translation both from and to for general document translation tasks. Figure 4-10 shows the Translation
Language Options dialog box. Click the arrows to select your language preferences and then click OK.

Translation Language Options ? @

.
a& Choose translation languages

Choose Mini Translator language

Translate to: Spanish (International Sort) ﬂ

/1y Text for translations is sent over the Internet in unencrypted HTML format to a machine translation provider.
The Mini Translator will remain on every time the application is used.

Choose document translation languages

Translate from: | Spanish (International Sort)

Translate to: English (U.S.) E

o New translation services are available. Click here to update.

OK ]l Cancel ]

Figure 4-10 Set your translation languages using the Translation Language Options dialog box.

The Mini Translator tool includes an Update Services tool on the far right side of the popup box that
enables you to make sure you’ve got the most up-to-date translations available. Click it to search online
for any translation updates.
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Figure 4-11 The Mini Translator enables you to translate words, phrases, or blocks of text as you work.

Working with Shared Documents

The Note Board feature shown in Figure 4-13 is not available in the release of Office 2010. You can work
with document versions, set permissions, interact with co-authors, and check the upload status of your
document in Backstage view.
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Figure 4-13 You can get information about your shared document in Backstage view.



CHAPTER 5

Create Smart Data Insights with Excel 2010

Step by Step: Use Improved Icon Sets to Highlight Data

Tip You can do much more with icon sets in Excel 2010. To learn more about the different ways you can
spotlight the data on your worksheets, see Microsoft Office 2010 Plain & Simple, by yours truly. ©

New SmartArt Enhancements

Excel 2010 adds the new Picture category to the types of SmartArt diagrams you can create. You can
also search easily for new SmartArt styles by clicking Office.com in the left side of the SmartArt dialog
box.
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Figure 5-5 The new Picture category is new in SmartArt, and now you can search for more SmartArt on
Office.com.



CHAPTER 6

Manage Rich Communications with Outlook
2010

Managing Your Conversations

Conversation view is one of the big improvements in the released version of Office 2010, but it is no
longer enabled by default. You can turn on Conversation view by clicking the View tab and clicking the
Show as Conversations check box in the Conversations group.

You can also customize the way Outlook shows the conversation threads in your version of the program
by clicking View and choosing Conversation Settings. Then you can choose whether you want to show
the sender’s name above the subject, expand all conversations, and indent replies in the thread.
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Figure 6-4A You can set Conversation options in the View tab.

Step by Step: Following E-mail Conversations

1. Display Conversation View by clicking the view tab and clicking the Show as Conversations check

box.



Table 6-1 Introducing Quick Steps
The Quick Steps that are available with the release version of Office 2010 are the following:

e Move to:?

e To Manager

e Team E-mail

e Done

o Reply & Delete
e Create New

Step by Step: Create a Custom Quick Step

1. Click Create New in the Quick Steps group and enter a new name for the Quick Step.



CHAPTER 7

Produce Dynamic Presentations with

PowerPoint 2010

Save Your Presentation as a Video

Another new feature in PowerPoint 2010 makes it easy for you to save your presentation as a video and
share it with others. Click File to display Backstage view and click the Save & Send tab. Then click Create

A Video to display the available video options.
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Figure 7-12 Create a video of your PowerPoint presentation.




CHAPTER 8

Organize, Store, and Share Ideas with OneNote
2010

No changes for the release version.



CHAPTER 9

Collaborate Effectively with SharePoint
Workspace 2010

No changes for the release version.



CHAPTER 10

Create Effective Marketing Materials with
Publisher 2010

Sharing Publisher Files

You can share the files you create in Publisher 2010 in various ways. You can e-mail pages from within
Publisher, create a PDF/XPS document, publish the document as HTML, save the piece for a commercial
printer, or save the publication for another computer. You can also share a template you create with the
Publisher Template community. You'll find these options in the Save & Send tab of Backstage view.
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Figure 10-12 You can choose to share your Publisher document in a variety of ways.



CHAPTER 11

Make Sense of Your Data with Access 2010

No changes for the release version.



CHAPTER 12

Putting It All Together

No changes for the release version.



CHAPTER 13

Security in Office 2010

Working with Protected View

In the release version of Office 2010, the Enabled Protected View for Files That Fail Validation feature
has been removed, so only three options remain in the Protected View settings:

Trust Center [i‘@

Trusted Publishers
4 Protected View

Trusted Locations
Protected View opens potentially dangerous files, without any security prompts, in a restricted mode to help minimize harm
to your computer. By disabling Protected View you could be exposing your computer to possible security threats.

V| Enable Protected View for files originating from the Internet

Trusted Documents

Add-ins V] Enable Protected View for files located in potentially unsafe locations (:
ActiveX Settings V] Enable Protected View for Outlook attachments

Macro Settings Data Execution Prevention

Protected View (V] Enable Data Execution Prevention mode (i

Message Bar
File Block Settings

Privacy Options

oK Cancel |

Figure 13-3 You can change the Protected View settings used to protect your computer.

Recovering Unsaved Versions

Just a small change in this section. The name of the feature shown in Figure 13-8 has changed from
Recover Draft Versions to Recover Unsaved Versions.
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Figure 13-8 You can recover unsaved drafts and work with versions in Backstage view.

Tip You can also recover unsaved documents by clicking the Recover Unsaved Documents folder
icon in the bottom right corner of the Recent tab in Backstage view.



CHAPTER 14

Training Made Easy

No changes for the release version.

Katherine Murray is the author of First Look Microsoft Office 2010, Microsoft Office 2010 Plain & Simple, Microsoft
Word 2010 Plain & Simple, and Microsoft Word 2010 Inside Out, all from Microsoft Press.



